About the Tutorial

Microsoft PowerPoint is a commercial presentation application written and distributed by
Microsoft for Microsoft Windows and Mac OS X. The current versions at the time of writing
this tutorial are 2010 for Microsoft Windows and 2011 for Mac OS X.

Microsoft PowerPoint is a presentation tool that supports text, shapes, graphics, pictures
and multimedia along with integration with other Microsoft Office products like Excel.

By default, documents saved in PowerPoint 2010 are saved with the .pptx extension
whereas, the file extension of the prior PowerPoint versions is .ppt.

Audience

This tutorial has been designed for computer users who are willing to learn Microsoft
PowerPoint in simple steps and they do not have much knowledge about computer usage
and Microsoft applications. This tutorial will give you enough understanding on MS
PowerPoint from where you can take yourself at higher level of expertise.

Prerequisites

Before proceeding with this tutorial you should have a basic understanding of Computer
peripherals like mouse, keyboard, monitor, screen, etc. and their basic operations.
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1. PowerPoint 2010 —Getting Started

In this chapter, we will understand how to get started with PowerPoint 2010. We will
understand how to start PowerPoint 2010 application in simple steps. To access PowerPoint
2010, you must have Microsoft Office 2010 installed in your PC. Only Office 2010 Home
and Student, Home and Business, Standard, Professional and Professional Plus packages
have PowerPoint included in them. Other packages may have a viewer, but you cannot
create presentations with them.

Step 1: Click the Start button.
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Step 2: Click All Programs option from the menu.

All Programs

Step 3: Search for Microsoft Office from the sub menu and click it.

Microsoft Office
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Step 4: Search for Microsoft PowerPoint 2010 from the submenu and click it

Microsoft PowerPoint 2010

This will launch the Microsoft PowerPoint 2010 application and you will see the following
presentation window.

Click to add title

Chck to add subtitle
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2. PowerPoint 2010 —Exploring Windows

The following screenshot shows the various areas in a standard PowerPoint file. It is
important to familiarize yourself with these areas as it makes learning and using
PowerPoint easier.
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File Tab

This tab opens the Backstage view which basically allows you to manage the file and
settings in PowerPoint. You can save presentations, open existing ones and create new
presentations based on blank or predefined templates. The other file related operations
can also be executed from this view.

Ribbon
r—————— Y ot i
TN recentation] - Microsoft PowerPoint (C=ROR X
Home Insert Design Transitions Animations Shide Show Review View A 0
_-]' . . P '. \ _l H ‘

_J by B 7 U 8§ a2} = I= : o =
New Shapes Arrange Editing
Slide ~ b A A A v . . v

des Font Paragraph Oraw

The ribbon contains three components:

¢ Tabs: They appear across the top of the Ribbon and contain groups of related
commands. Home, Insert, Page Layout are examples of ribbon tabs.

¢ Groups: They organize related commands; each group name appears below the

group on the Ribbon. For example, a group of commands related to fonts or a group
of commands related to alignment, etc.

¢ Commands: Commands appear within each group as mentioned above.

Title Bar

This is the top section of the window. It shows the name of the file followed by the name
of the program which in this case is Microsoft PowerPoint.

Slide Area

This is the area where the actual slide is created and edited. You can add, edit and delete
text, images, shapes and multimedia in this section.
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Help

The Help Icon can be used to get PowerPoint related help anytime you need. Clicking on
the "?" opens the PowerPoint Help window where you have a list of common topics to
browse from. You can also search for specific topics from the search bar at the top.

Search Bar Browse by Topics

=100 @ A B AP R
/pSearchv

PowerPoint Help and [Aow-to

Browse PowerPoint Help

What's new Installing

Activating PowerPoint

File management

Working with text

Working with tables

Working with SmartArt
graphics
Working with shapes

Organizing and formatting
slides

Using masters
Working with animation

Working with movies

Woerking with transitions

Getting help

Getting started with
PowerPoint

Spelling, grammar, and
thesaurus

Working with charts
Woerking with pictures

Working with WordArt

Using themes

Using templates
Working with sounds

Working with hyperlinks
and action buttons

Reviewing and adding
comments

PowerPoint Help |

| Offline

Zoom Options

The zoom control lets you zoom in for a closer look at your text. The zoom control consists
of a slider that you can slide left or right to zoom in or out, you can click on the -and +
buttons to increase or decrease the zoom factor. The maximum zoom supported by
PowerPoint is 400% and the 100% is indicated by the mark in the middle.
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Slide Views

The group of four buttons located to the left of the Zoom control, near the bottom of the
screen, lets you switch between PowerPoint views.

¢ Normal Layout view: This displays page in normal view with the slide on the right
and a list of thumbnails to the left. This view allows you to edit individual slides and
also rearrange them.

¢ Slide Sorter view: This displays all the slides as a matrix. This view only allows
you to rearrange the slides but not edit the contents of each slide.

¢ Reading View: This view is like a slideshow with access to the Windows task bar
in case you need to switch windows. However, like the slideshow you cannot edit
anything in this view.

Notes Section

This sections allows you to add notes for the presentation. These notes will not be
displayed on the screen during the presentation; these are just quick reference for the
presenter.

Quick Access Toolbar

The Quick Access Toolbar is located just under the ribbon. This toolbar offers a convenient
place to group the most commonly used commands in PowerPoint. You can customize this
toolbar to suit your needs.

Slide Tab

This section is available only in the Normal view. It displays all the slides in sequence. You
can add, delete and reorder slides from this section.



3. PowerPoint 2010 - Backstage View

In Office 2010, Microsoft replaced the traditional file menu with the new Backstage view.
This view not only offers all the menu items under the file menu, but additional details
which makes management of your files a lot easier.

AccessingBackstageView

You can access the Backstage view simply by clicking on the File tab. You can exit this
view by clicking on any tab (including the File tab again). You can also press the 'Esc'
button on the keyboard.
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Organization of Backstage View

PowerPoint 2010

The backstage view has three sections or panes.
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¢ First Pane: This is the commands pane which consists of all the commands you would
typically find in the file menu of older versions. You also have the Options menu which
lets you edit the options on the program like customizing the ribbon.

Various commands under the first pane are described in the table below:

Command

Description

Save

This allows you to save a new file or an existing file in
standard format. If you are working on a previously saved

file this will save the new changes in the same file format. If
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you are working on a new file, this command would be similar
to the Save As command.

Save As Allows you to specify the file name and the file type before
saving the file.
Open Allows you to open new PowerPoint files.
Close Allows you to close an existing file.
Info Displays the information about the current file.
Recent Lists series of recently viewed or edited PowerPoint files.
New Allows you to create a new file using blank or pre-defined
templates.
Print Allows you to select the printer settings and print the
presentation.
Save & Send Allows you to share your presentation with larger audience
via emails, web, cloud services, etc.
Help Provides access to PowerPoint Help.
Options Allows you to set various options related to PowerPoint
program.
Exit Closes the presentation and exits the program.

Second Pane: This is the subcommands pane. This will list all the commands
related to the main command you choose in the first pane. For example, if you
select Print in the first pane, you get to choose the printer and adjust the print
settings in the second pane.

Third Pane: This is the preview or file information page. Depending on the
command and the subcommand you select, this pane will either display the
properties of the file or give you a preview of the file.

1(



4. PowerPoint 2010 —Creating Presentation

PowerPoint offers a host of tools that will aid you in creating a presentation. These tools
are organized logically into various ribbons in PowerPoint. The table below describes the

various commands you can access from the different menus.

Menu Categories Ribbon Commands

Presentationl - Microsoft Pe
—

File Home ' Insert Design Transitions Animations Slide Jhow Review View

Drawing| Editing
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Clipboard 1= Slides Font
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Click to add title

Clickto add subtitle

Click to add notes

Slide1of1 | “Office Theme™ | <4 |
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Menu Category Ribbon Commands

Home Clipboard functions, manipulating slides, fonts, paragraph
settings, drawing objects and editing functions

Insert Insert tables, pictures, images, shapes, charts, special texts,
multimedia and symbols

Design Slide setup, slide orientation, presentation themes and
background
Transitions Commands related to slide transitions
Animations Commands related to animation within the individual slides
Slideshow Commands related to slideshow set up and previews
Review Proofing content, language selection, comments and comparing

presentations

View Commands related to presentation views, Master slides, color
settings and window arrangements

Besides these depending on the objects selected in the slide, there are other menu tabs
that get enabled.

12



5. PowerPoint2010 - Adding New Slides

In this chapter, we will understand how to add new slides in an existing presentation. Here
are the steps that allow you to insert a new slide in the deck:

Step 1: Right-click in the Navigation Pane under any existing slide and click on the New
Slide option.

Navigation Pane

Presentation3 - Microsoft PowerPoint |l ‘g

Home | Insert  Design  Transitions  Animations  Slide Show  Review View & 9
— A
= |l 4} o)

Drawing Editing

v JF v - T —
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—]*;g B 7/ U 8 Y- EE B

New 3 - - Ad - = ==
Slider " A - Aa A A ) B = =

Slides Font Paragraph
1 ﬂ[ l
& Cut
43 Copy
(Y Paste Options:
3
=) New Slide
plicate Slide
elete Slide
~j 4dd Section
heck for Updates >
&5 fayout »
Reset Slide
& format Background... E =t
2
T v
PRI Hide Slide £ Wi T~ —~ (Y3
Slide 1 of 1 f\"' el (Ca0203) ||[El2 BT s (0

New Slide Option
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Step 2: The new slide is inserted. You can now change the layout of this slide to suit your
design requirements.

New Slide Inserted

FA =00 3 M i Pl Ml rin -

Transitions  Animations  SlideShow  Review

B Z U § she AV
A-Aa | AL &
Font :

Click to add title

* Clickto add text

s P

bl B &3

Step 3: To change the slide layout, right-click on the newly inserted slide and go to the
Layout option where you can choose from the existing layout styles available to you.
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Layout Menu Option
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You can follow the same steps to insert a new slide in between existing slides or at the

end on the slide list.

When we insert a new slide, it inherits the layout of its previous slide with one exception.
If you are inserting a new slide after the first slide (Title slide), the subsequent slide will

have the Title and Content layout.

You will also notice that if you right-click in the first step without selecting any slide the
menu options you get are different, although you can insert a new slide from this menu

too.
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Click to add title

Click to add subtitle

PowerPoint 2010

16



6. PowerPoint2010— Adding Text in Boxes

PowerPoint allows users to add text to the slide in a well-defined manner to ensure the
content is well distributed and easy to read. The procedure to add the text in a PowerPoint
slide is always the same - just click in the text box and start typing. The text will follow
the default formatting set for the text box, although this formatting can be changed later
as required. What changes is the different kinds of content boxes that support text in a

PowerPoint slide.

Given below are some of the most common content blocks you will see in PowerPoint.

Title Box

This is typically found on slides with the title layout and in all the slides that have a title
box in them. This box is indicated by "Click to add title".

Title Box

Subtitle Box
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Subtitle Box

This is found only in slides with the Title layout. This is indicated by "Click to add
subtitle".

Content Box

This is found in most of the slides that have a placeholder for adding content. This is
indicated by "Click to add text". As you can see, this box allows you to add text as well
as non-text content. To add text to such a box, click anywhere on the box, except onone
of the content icons in the center and start typing.

T T P P e PP PP PP PPy

Click to add title

° Click to add text

Non-Text Content Icons
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Text Only Box

This is not a default content box available in PowerPoint, but you can create it using Slide
Master, if required. This is also indicated by "Click to add text". The only difference

between the Text Only Box and the Content Box is that the former only supports text
in the content area.
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7. PowerPoint2010— Adding New Text Boxes

This chapter will teach you how to add new text boxes in a slide. Most of the standard
layouts come with the text box option. As mentioned in the previous chapter, text boxes
will have "Click to add text" as the default text. Here are the steps to add new text boxes
in slide.

Step 1: Click on the Text Box icon in the Home ribbon under the Drawing section.
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Step 2: You will get the insert text box cursor that looks like an inverted cross

Step 3: Click to insert a text box. You can now start typing directly into the text box

Newly Inserted Text Box

)

LR

Click to add notes
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Step 4: Alternately, you can click and drag the cursor without releasing the click to
create a text box.
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The size of the text box can be adjusted by selecting one of the edges marked by squares
or corners marked by circles.

Corners

J

——— — v}

) 2o 1 L
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8. PowerPoint 2010 — Deleting Existing Slide

There are times while building a slide deck, you may need to delete some slides. This can
be done easily from PowerPoint. You can delete the slides from the Normal view as well
as the Slide Sorter view. In each view, you can delete the slides in two ways.

Deleting from Normal View

Step 1: Go to the Normal view.

’
@) Title Slide2.pptx - Microsoft PowerPoint =)
Home Insert Design Transitions Animations Stide Show Review View o 0
R | =l & - [e] | [
: d3- bor B 7 U 8 abe AV = IE | OEE =
Paste New 2 7 . B N Drawing Editing
M J Slide* " A An A A -y === = v -
Clipboard & Shides Font Paragraph
H9-0 =
J | B A
. e, ....................... s .........................................
- Click to add title
2 * Click to add text a

Py
. iy
‘ 7 -
-
S 2
;
i E
|_Click to add notes = — m—
Slide20f 5 | “Office Theme™ | 4  English (Canada) | |Bj8 P 4% (=) U ONY |

!

Normal View icon

24



PowerPoint 2010

Step 2: Right-click on the slide to be deleted and select the Delete Slide option.
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Alternately, you can select the slide and press the Delete button on your key board.
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Deleting from Slide Sorter View

Let us now understand how to deleted slides from the Slide Sorter View.

Step 1: Go to the Slide Sorter view.

b nzna;uhv. ;ii:'uﬂzsun @Q&i& 8
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Slide Sorter View icon
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Step 2: Right-click on the slide to be deleted and select the Delete Slide option.

= Add Section

Check for Updates
&4 Format Background..,
Hide Slide

Alternately, you can select the slide and press the Delete button on your key board.
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9. PowerPoint 2010 —Rearranging Slides

Rearranging slides is important when it comes to organizing the overall presentation flow.
While it is vital that you get the right content in every slide, it is equally important that
you are able to present them in a format that makes it easier for the audience to
understand the content too; most times this will require rearranging the slides.

You can rearrange slides from two views in PowerPoint - Normal View and Slide Sorter
View. Given below are the steps to rearrange slides from different views.

Normal View

Step 1: Select the slide to be moved

Step 2: Leftclick on the slide and drag it to the position in the sequence where you want
to place it. PowerPoint will indicate the insert position with a line in-between existing slides.
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Step 3: When you get to the right position release the left click button to insert the slide.
Alternately you can also cut the selected slide and paste it back in the sequence as shown

below.
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SlideSorter View

Let us now understand how the Slide Sorter View works.

Step 1: Select the slide to be moved.

Step 2: Left click on the slide and drag it to the position in the sequence where you want
to place it. PowerPoint will indicate the insert position with a line in-between existing slides.
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Step 3: When you get to the right position, release the left click button to insert the slide

Alternately you can also cut the selected slide and paste it back in the sequence as shown
below.
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